
In this chapter

• Working with form properties

• Creating your own controls

• Using sections and subforms effectively

13

Customizing Forms

By now you’ve got a good handle on how to manage the data in your

Access applications. You can create and customize tables to store your

data, and you know how to build the queries to present that data as

information. Now it’s time to turn your attention back to the user inter-

face of your Access database. So far, you’ve let Access do most of the

work of building forms for you. In this chapter, we’ll show you how to

tap the power of form design view to make your Access forms more

usable and flexible and to make them look the way you want. This is

also a good time for you to learn about the object dependencies task

pane, which helps you keep track of how everything in your database

fits together.
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Setting Form Properties
Like just about everything else in Access, forms
have properties. The properties of a form control
some of its behavior, as well as its look and feel.
For example, you can use form properties to pre-
vent data from being accidentally deleted or to
change the background color of a form from
gray to lime green. In this section, you’ll learn
about two ways to set the properties of your
forms. For a quick facelift, you can use the
AutoFormat function. On the other hand, for
complete control over all aspects of your forms,
you can use the Properties window.

Using AutoFormat
AutoFormat in Access provides an easy way to
change the overall appearance of a form.
Although this tool is easy to use, it requires you to
work with your form in design view. That’s nothing to be scared of—we’re going to
work almost exclusively with design view in this chapter—but you need to be care-
ful. In design view, you can change any aspect of a form, including things (such as
its connection to the underlying data) that you might not want to alter.

Here’s how you can use AutoFormat to dress
up the Catalogs form:

1. Select the Forms shortcut in the
Database window.

2. Select the Catalogs form.

3. Click the Design button on the
Database Window toolbar to open the
form in design view.

4. Select Format, AutoFormat, or click
the AutoFormat button on the tool-
bar. Either way, the AutoFormat dialog
box will open, as shown in Figure 13.1.
Notice that the Standard option is the default format; this feature defaults to
the format last used, so don’t worry if your system choose a different option.
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You can download the
Chapter 13.mdb sample

file, which is inclusive of all the
examples in this chapter, from
http://www.quepublishing.com/.
If you want to follow along with
our examples, download Chapter
12.mdb.

tip
If you make a mistake in

design view (such as delet-
ing a control you meant to
keep), just close the form
and click No when Access

asks if you want to save
changes.
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5. The list at the left side of the AutoFormat dialog box includes all the avail-
able AutoFormats. As you click each one, the center section of the dialog box
changes to show you a preview of the format. Select the Blends AutoFormat.

6. Click OK to apply the AutoFormat.

7. Select View, Form View to see the form with the selected AutoFormat
applied, as shown in Figure 13.2.
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FIGURE 13.1

The AutoFormat

dialog box.

FIGURE 13.2

In just a few

quick steps, you

completely

reformatted this

form.
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8. Click the Save button on the toolbar to save the changes to the form. Close
the form when you’re done inspecting the results.

Applying an AutoFormat to a form doesn’t affect any of the form’s functions.
Instead, it makes changes to the form’s appearance. In particular, it can change the
font used for labels and text, the color used for controls, the image used for the
form’s background, and the borders used around controls.

You can do two other things in the AutoFormat dialog box. First, if you click
Options, you can selectively choose whether to apply the AutoFormat to fonts, col-
ors, and borders or to leave them alone. Second, you can click Customize to modify
the available AutoFormats as follows:

■ You can create a new AutoFormat based on the contents of the current form.

■ You can change the selected AutoFormat to match the current form (instead
of changing the form to match the AutoFormat).

■ You can delete an AutoFormat entirely.

When you come up with a look that you particularly like for a form, you can use
the AutoFormat options to turn this look into a new AutoFormat. Then, you can
apply that AutoFormat to the other forms in your database, allowing you to easily
create a consistent user interface. You’ll learn more about customizing AutoFormats
in Chapter 14, “Dressing Up Your Reports.”

Using the Properties Window
You’ll recall from previous chapters that properties
are the values that describe a particular object.
Similar to other objects in Access, forms have a
set of properties that control their appearances
and behaviors. To change the properties of a
form, you can use the Properties window. Some
properties you can even change in form view.
Here’s an example:

1. Open the Plants form in form view.
You’ll see the first record in the Plants
table displayed on the form.

2. Do one of the following: select View,
Properties or click the Properties tool-
bar button (as usual, Access provides
more than one way to do things). This
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AutoFormats are stored
in Access itself, not in indi-

vidual databases. So, if you create
a new AutoFormat in one data-
base, you can use it in all your
databases.
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opens the Properties window, as shown in Figure 13.3, which displays the
properties of the control that has the focus (in this case, the CommonName
text box). (Pressing F4 will open the Properties window in design view.)
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FIGURE 13.3

Viewing the

Properties win-

dow.

3. Click twice—slowly (don’t double-click)—in the gray area between the con-
trols on the form. The Properties window changes to show the properties of
the form itself.

4. Click the Format tab in the Properties window.

5. Scroll down the list of properties to locate the Picture property, which is cur-
rently set to (None). Click in this property to reveal a build button.

6. Click the build button to open the Insert Picture dialog box. Browse to the
Windows directory on your computer, and select the FeatherTexture.bmp file.
Click OK.

7. Select the Picture Tiling property and change its value from No to Yes.
Figure 13.4 shows the resulting form.

8. Close the Properties window and save the form.

Unlike AutoFormat, you can use the Properties window no matter which view you’re
using to display a form—either design view or form view. As you saw in this exam-
ple, changes made through the Properties window take effect immediately (in form
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view). The changes aren’t permanent, though, unless you save the form after mak-
ing the changes.
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FIGURE 13.4

A form with

new properties.

What else can you change with the Properties window? Anything! Well, just about.
In fact, if you look at the properties that appear for the form, you’ll find an almost
frightening array of properties. Fortunately, you won’t need to use most of these.

Five tabs appear at the top of the Properties window. As you click these tabs, the
window displays different sets of properties. These tabs are as follows:

■ Format—Properties that control the appearance of the selected item

■ Data—Properties that control the data displayed by the selected item

■ Event—Properties that control the code executed by the selected item

■ Other—Properties that don’t fit into one of the three previous classes

■ All—All the properties of the item in one big list

We won’t discuss event properties in this chapter; you’ll learn a bit about them in
Chapter 15, “Automating Your Database.” In this chapter, you’ll work only with
properties from the Format, Data, and Other categories.

Table 13.1 lists some of the properties of the form that you might find useful.

TABLE 13.1 Properties of an Access Form
Property Meaning

Record Source The table or query from which the form gets its data

Caption The text displayed at the top of the form

Allow Edits Controls whether the form can be used to edit data

Allow Deletions Controls whether the form can be used to delete data

Allow Additions Controls whether the form can be used to add data

Scroll bars Controls whether scrollbars appear on the form
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Record Selectors Controls whether record selectors (the bars to the left of the data)
appear on the form

Navigation Buttons Controls whether the navigation bar appears at the bottom of the form

Dividing Lines Controls whether lines appear between the records when the form is
displayed in continuous forms view, as well as whether lines appear
between sections of the form, such as the detail section and footer
section

Auto Resize Controls whether the form automatically resizes to show all its con-
trols when it is opened

Auto Center Controls whether the form is automatically centered on the screen

Picture The picture (if any) to use for the form’s background

Picture Size Mode Specifies whether any background picture should be stretched to fill
the form

Picture Tiling Controls whether any background picture should be repeated to fill
the form

Moveable Controls whether the form can be moved onscreen after it has been
opened

Here’s how you might use some of these properties to further customize the Catalogs
form:

1. Open the Catalogs form in design view.

2. If the Properties window is not already open, press F4 to open it.

3. Select the Format tab.

4. Double-click in the Dividing Lines property to change its value from Yes to No.

5. Change the Navigation Buttons property to No.

6. Select the Data tab.

7. Change the Allow Deletions property to No.

8. Close the property sheet.

9. Select Form View from the View drop-down list on the toolbar. The form will
display as shown in Figure 13.5. Note that the dividing lines and navigation
bar are gone.

10. Click in the navigation bar to the left of one of the records, and then press
the Delete key. Access will beep, and the status bar will display the message
Records can’t be deleted with this form.

11. Save and close the form.
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Using the Field List
Another tool that’s available only in design
view is the Field List. The Field List enables you
to easily add new data to be displayed on a
form. To see the Field List in action, you’ll
build a new form based on the Plantings table,
which doesn’t yet have a user interface in the
database. To add one, follow these steps.

1. Select the Forms shortcut in the
Database window.

2. Click the New button on the Database
Window toolbar.

3. In the New Form dialog box, select Design View. Then select the Plantings
table in the data source combo box, as shown in Figure 13.6.

4. Click OK to create the form and open it in design view.

5. Access might automatically display the Field List. If it doesn’t, either click the
Field List button on the toolbar or select View, Field List. The Field List
(shown in Figure 13.7) lists all the fields in the table or query on which the
form is based—in this case, the Plantings table.

6. To add controls to the form, you can drag and drop items from the Field List.
For example, select the DatePlanted field in the Field List; then drag and
drop it onto the form. When you release the mouse button, Access creates a
label and text box for this field.

7. Drag and drop the Notes and Future fields from the Field List to the form.
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FIGURE 13.5

The Catalogs

form after fur-

ther design

work.

Setting Allow Deletions
to No only prevents
deleting entire records.
You can still delete the
contents of any individual
control. 

caution

18 0789729407 CH13  8/26/03  8:18 AM  Page 234



8. Click the Save button on the toolbar. Name the form Plantings and click OK.

9. Select View, Form View to see your new form.

Chapter 11, “Customizing Your Tables,” discussed the fact that properties in Access
can be inherited from one object to another. The new Plantings form provides a
good example of this. Because you set properties on fields when you built the
Plantings table, the form automatically makes some settings for you:

■ The Caption property for each field is used as the text for the label on the
form.

■ The Description property for each field is displayed on the status bar when
that field is active.

■ The data type for each field is used to determine the type of control to dis-
play. That’s why the Future field (which accepts only Yes or No values) is dis-
played as a check box rather than as a text box.

■ The Format and Input Mask properties control the appearance and function
of the control that holds the Date field.

Access 2003 also keeps track of inherited properties as you work with the database.
For example, follow these steps to change a property in the Plantings table:

1. Close the Plantings form.

2. Select the Tables shortcut in the database window.
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FIGURE 13.6

Creating a new

form from

scratch.

FIGURE 13.7

The Field List.
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3. Open the Plantings table in design view.

4. Change the Description property of the DatePlanted field to Date that these
plants were planted.

5. When Access displays the Property Update Options icon, click it and select the
Update Status Bar Text everywhere DatePlanted is used option. 

6. In the resulting Update Properties dialog box, select only the forms that you
want to display the new Description, and click Yes.

7. Save and close the table.

8. Select the Forms shortcut in the database window.

9. Select the Plantings form.

10. Click the Open button.

11. Check the status bar of Access. You’ll see that the status bar text for the
DatePlanted control has been updated.

Using the Toolbox
The last major form design aid you need to know about is the Toolbox. The Toolbox
is used to add new controls (labels, text boxes, check boxes, and so on) to forms.
These controls can be attached to data (such as the text boxes and check box you
just created on the Plantings form), or they can be independent of any data (such as
the labels that contain the captions for those controls).

To see the Toolbox, place a form in design view
and either click the Toolbox button on the toolbar
or select View, Toolbox. Figure 13.8 shows the
Toolbox and the buttons it contains (your
Toolbox might be shaped differently; you can
drag the borders to control its size and shape).

Most of the buttons on the Toolbox are used to
select the type of control with which you want to
work. We’ll show you how to use the following
six common buttons later in this section of the
chapter:

■ Label—Used to display unbound text

■ Text box—Used to display an area in
which the user can type

■ Check box—Used to allow making a yes or no choice
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In Access, a control that
is attached to data is called

a bound control. A control that is
independent of data is called an
unbound control.
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■ List box—Used to display a list of information

■ Combo box—Used to display a drop-down list of information

■ Command button—Used to display a button

Three of the buttons in the Toolbox have special meanings:

■ Select Objects arrow—Used to choose an already existing control with
which to work.

■ Control Wizards button—Turns the Control Wizards on or off. You should
have them turned on for now.

■ More Controls button—Allows you to add more controls to the Access
Toolbox. We won’t be using this button in this book.

Labels
Perhaps the simplest of all controls is the
Label control, which is designed for display-
ing information, not editing information.
When you see field names or captions dis-
played on a form, those are all Label controls.
Although Label controls are not as complex
as other controls, they do offer an easy way to
practice some essential form design opera-
tions: placing, moving, sizing, and changing
the properties of controls. Start by following
these steps to add some Label controls to the
Plantings form:
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Control wizards
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Rectangle
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Page
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Unbound
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Image
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Toggle
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Option
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Text box

Label
Select objects

FIGURE 13.8

The Toolbox.

tip
When you’re learning your

way around design mode,
the Control Wizards can save
you a lot of time. Later, when
you’re more of an expert,

you might want to turn
them off and set the con-

trol properties by hand.
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1. Open the Plantings form in design view. If the form is still on your screen in
form view, you can select View, Design View to change it back.

2. Click the Label control in the Toolbox, and move your cursor to the form. It
will display a crosshair and a capital letter A, indicating that it is ready to
create a label. Click and hold the mouse button where you want the upper-
left corner of the new label to be on the form. Then, drag the cursor down
and to the right. A box will appear as you drag, indicating the dimensions of
the new control.

3. Release the mouse button; the label will be displayed as a blank, white box
with a blinking cursor. Type the text Number Planted and click Enter to finish
creating the label. Access will place an alert Smart Tag next to the new label.
If you hover your cursor over the alert, you’ll see the text “This is a new label
and is not associated with a control.” That’s nothing to worry about; you’ll
create the associated control later.

4. Create a second label beneath the first one, following the same steps. Enter
the text Purchase Price for the second label.

You might not have managed to place the controls precisely where you want them
when you created them. That’s okay because Access offers flexible ways to control
the sizes and positions of controls. Try these steps to see how you can alter the place-
ment of the new controls:

1. Click in the Number Planted control, and Access displays eight dark boxes
around the control. These boxes are called sizing handles; there’s one at each
corner of the control and one in the middle of each side of the control.

2. To resize the control, click one of the sizing handles, hold down the mouse
cursor, and drag the handle in the direction in which you want to move that
part of the control.

3. To make the control exactly the right size to display its contents, double-click
any one of the sizing handles.

4. To move the control, move the cursor until it is over one of the sides of the
control, between sizing handles. The cursor turns into an open-palmed hand
at this point. Click and hold the mouse button, and you can drag the control
wherever you want to place it.

5. Press F4 to display the Properties window if it’s not already visible.

6. Click the Format tab of the Properties window.

7. Four properties dictate the size and position of the control. The Left property
measures the distance between the left side of the control and the left side of
the form, whereas the Top property measures the distance between the top of
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the control and the top of the form. The Width property measures the width
of the control, and the Height property measures the height of the control.
Type a new value in one of these properties, and you’ll see the control imme-
diately change in response.

8. With the Number Planted control still selected, hold down the Shift key and
click the Purchase Price control. This results in both controls being selected,
as shown in Figure 13.9. Note that the Properties Window now displays val-
ues for the properties that the two controls have in common. For example,
they’re both the same height, so the Height value is displayed; but they have
different widths, so the Width value is missing. 
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FIGURE 13.9

The Properties

window with

multiple con-

trols selected.

9. Type a value in the Properties window for the Left property. You’ll see that the
new value is applied to both selected controls.

10. Select Format, Size, To Widest to make both controls the same width. The
other choices on the Format, Size submenu offer other ways to make multiple
controls the same width or the same height.

11. Hold down Shift and click the Purchase Price control again. This deselects
that control, leaving only the Number Planted control selected.

12. Drag the Number Planted control to the left or right so that the two con-
trols are not lined up vertically.
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13. Place the mouse cursor at a point below and to the right of both controls.
Now hold down the mouse button and drag the mouse up and to the left;
Access draws a box that follows the mouse pointer as you do this. When the
box includes both controls, release the mouse button. Both controls are now
selected.

14. Select Format, Align, Left to set the Left property of both controls to the
same value. The Format, Align submenu contains other choices for aligning
controls.

Besides the sizing and placement properties, many other properties are available,
even for a control as simple as the Label. Inspecting the Properties window with a
Label selected shows you the entire list. Table 13.2 lists some of the properties that
you’ll most likely find useful as you’re starting out.

TABLE 13.2 Properties of the Label Control
Property Meaning

Name Each control on a form has a unique name. Until you start writing code,
you won’t need to worry about this. The caption of the Properties window
shows both the control type and the control name when you have a con-
trol selected. 

Caption Specifies the text displayed in the control.

Left Specifies the distance between the left edge of the control and the left
edge of the form.

Top Specifies the distance between the top edge of the control and the top
edge of the form.

Width Specifies the width of the control.

Height Specifies the height of the control.

Back Style Specifies whether the background of the control is transparent.

Back Color Specifies the background color of the control.

Special Effect Specifies the 3D appearance (if any) of the control.

Border Style Specifies the style of line used to draw the box around the control in form
view.

Border Color Specifies the color of the line around the control in form view.

Border Width Specifies the width of the line around the control in form view.

Fore Color Specifies the color of the text in the control.

Font Name Specifies the font used to display text in the control.

Font Size Specifies the size of the text in the control.

Font Weight Specifies the boldness of the text in the control.
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Font Italic Controls whether the text in the control appears in italic.

Font Underline Controls whether the text in the control appears underlined.

ControlTip Text Specifies the control tip to appear when the user hovers the cursor over
the control.

You can set any of the properties listed in
Table 13.2 by making entries directly in the
Properties window. However, user interface
shortcuts exist for some of these properties as
well. Follow these steps to explore some of the
properties of the Label control:

1. Select the Purchase Price control.

2. Click the drop-down arrow next to the
Fill/Back Color button on the tool-
bar. Select a background color for the
control by clicking one of the color
patches that appears.

3. Click in the Fore Color property in the
Properties window. A build button appears to the right of the property—click
it.

4. Select a color from the Color dialog box and click OK to assign that color to
the text of the control.

5. Click the drop-down arrow next to the Special Effect button on the toolbar;
then select the Shadowed special effect.

6. Click in the Font Name property in the Properties window. A drop-down
arrow appears; click a font name to assign that font to the control.

7. Double-click in the Font Italic property in the Properties window to switch
the property value from No to Yes.

8. Double-click one of the sizing handles for the control to ensure that it can
still display all its text.

You might have noticed that the Fore Color and Back Color properties display num-
bers in the Properties window. That’s because Access assigns a numeric code, ranging
from 0 to 16 million, to each of the colors it can display. If you pick a number at
random for a color property, you’ll get a random color—although generally it’s more
useful to use the toolbar buttons or the Color dialog box to select the color you want!
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Most of the properties of

the Label control also apply
to other types of controls.
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Text Boxes
Text boxes provide a control that can display data from a table and that a user can
use to edit or enter data. Most of the controls you’ve been working with on forms so
far in this book are text boxes. You’ll find that all your skills from manipulating
labels apply equally well to text boxes. In fact, all controls are sized, placed, and so
on using the same techniques.

Follow these steps to add some text boxes to the Plantings form:

1. Select the Text Box tool in the Toolbox. The Properties window displays the
default properties for a text box control. Set the Auto Label property to No.

2. Now move your cursor to the form. It displays a crosshair and control with
letters in it, indicating that it is ready to create a text box. Click and hold the
mouse button where you want the upper-left corner of the new label to be on
the form; start just to the right of the Number Planted label. Then, drag the
cursor down and to the right. A box appears as you drag, indicating the
dimensions of the new control.

3. Release the mouse button, and the text box is displayed with the contents
Unbound.

4. Click in the Control Source property to display both a drop-down arrow
and a build button. Click the drop-down arrow and select NumberPlanted
from the list.

5. Hold down Shift and click the Number Planted label so that both the text
box and the label are selected. Use the Format menu to size and align the
two controls.

6. Click the Text Box control in the Toolbox again.

7. Set the Auto Label property to Yes.

8. Draw another text box on the form. This time, however, when you release the
mouse button, Access creates both a Text Box control and a Label control.
Both controls will be selected.

9. Move the cursor until it is over the edge of one of the controls and displays
the open hand.

10. Click and drag the cursor; both controls move together.

11. Move the cursor over the upper-left sizing handle of one of the controls. At
this point, the cursor displays a hand with one finger sticking up. Click and
drag the cursor to move just that control, without moving the other control.

12. Set the Control Source property of the new text box to Bed.
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The Text Box control has many of the same properties as the Label control. However,
it also has other properties because it can contain data. Figure 13.10 shows the Data
tab of the Properties window with a Text Box control selected.
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FIGURE 13.10

Data properties

for a Text Box

control.

Many of the data properties of a Text Box control are familiar to you from table
design (and indeed, these properties inherit their values from the values assigned to
the corresponding table field). This includes the Input Mask, Default Value,
Validation Rule, and Validation Text properties. Three of the other properties on this
tab will be important to you as you design forms:

■ Control Source—Specifies the data field to which this control will be bound.
The Control Source will be a field from the Record Source specified for the
form.

■ Enabled—Controls whether the control is displayed as a live control. If you
set the Enabled property to No, the control is grayed out and the user is not
able to type in it.

■ Locked—Controls whether the user can enter data in the control. If you set
the Locked property to yes, the user cannot edit the data contained in this
control, but the control itself isn’t grayed out. 

Check Boxes
Check boxes are an appropriate control to use when you want the user to make a
yes/no choice. Indeed, the Form Wizard and the Field List use Check Box controls to
represent any data field with the Yes/No data type. That’s why the Future control on
the Plantings form is a check box.

If you select the Future control on the Plantings form, you’ll see that we’ve already
discussed many of the properties of the control. The following are two more proper-
ties we want to point out:
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■ Status Bar Text—Holds the text to be displayed on the Access status bar
when this control is selected. Access automatically initializes this property
from the description property of the corresponding table field, but you can
override that here if you want.

■ Triple State—Controls whether the control is just a yes-or-no choice or
whether it has a third, indeterminate state. If you set the Triple State property
to Yes, a Check Box control can be checked, unchecked, or grayed out. The
grayed-out state corresponds to a null value in the underlying table. 

List Boxes and Combo Boxes
List boxes and combo boxes are the most complex controls you’ll be working with as
you design your first databases. These controls actually relate data from one table to
data from another table. You can think of the List Box and Combo Box as little
machines that allow the user to pick a value from one table and then pump that
value into a field from another table.

Fortunately, although these controls are complex, they aren’t hard to build because
Access includes a Control Wizard to help you build them. Here’s how you can create
a simple List Box control: 

1. Open the Plants form in design view.

2. Make sure that the Control Wizards button in the Toolbox is selected. If it
isn’t, click it before you continue so Access will automatically launch the
appropriate control wizard. This button is a toggle button and remains
selected until you click it to deselect it.

3. Select the List Box control in the Toolbox.

4. Use the cursor to draw a control in the empty area of the form, just as you
earlier drew Label and Text Box controls. When you release the mouse but-
ton, instead of creating the new control, Access launches the List Box Wizard,
as shown in Figure 13.11.

5. On the first panel of the List Box Wizard, select I Want the List Box to
Look Up the Values in a Table or Query. Then, click Next.

6. On the second panel of the List Box Wizard, select the Types table as the
source of data for the List Box. Click Next.

7. On the third panel of the List Box Wizard, click the >> button to move both
the TypeID field and the Description field from the Available Fields list to the
Selected Fields list. Click Next.
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8. The next panel of the List Box Wizard allows you to specify a sort order for
the data. Select Description in the first combo box on this panel and then
click Next.

9. The next panel of the List Box Wizard, shown in Figure 13.12, displays the
way the List Box control will look. You’ll see that Access has chosen to hide
the TypeID column. Click Next.
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FIGURE 13.11

The first panel

of the List Box

Wizard.

FIGURE 13.12

Setting column

options in the

List Box Wizard.

10. On the sixth panel of the List Box Wizard, select Store That Value in This
Field. Select the TypeID field from the drop-down list and click Next.

11. Assign the name Type to the List Box. Then click Finish to create the list box.

12. Select View, Form View to see the effects of your changes. Figure 13.13
shows the form at this point.
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As you scroll through the records displayed by this form, you’ll notice that the new
List Box control and the existing Combo Box control always show the same selected
value. The reason is that they’re both bound to the same underlying field in the
Plants table. There’s nothing to prevent you from displaying the same data in two
different controls, although users of your database might find this a bit confusing.

The major difference between a list box and a combo box is that the list box shows
the entire list at all times, whereas the combo box shows only the selected value
until you click the drop-down arrow. A list box is also limited to the values that are
already in the list. A combo box, on the other hand, can let the user enter a value
that’s not in the list, although this capability is usually turned off.

To see the properties that control the behavior of a combo box or list box, switch the
Plants form back to design view and click the TypeID combo box (the one that
existed before you added the list box). Here’s what you’ll find: 

■ The Control Source property is set to TypeID—This is the field in the
Plants table in which the user’s selections are stored.

■ The Row Source Type property is set to Table/Query—In most cases,
this is the setting you’ll want here. You can also choose Value List, which lets
you embed the list directly on the form rather than taking it from another
table.

■ The Row Source property is set to SELECT Types.TypeID,
Types.Description FROM Types—You might recognize this as a select
query. Fortunately, you don’t have to build the row source by typing such
code in; when you click in the Row Source property, the Properties window
displays a build button that opens the query design grid. The row source
specifies the source of the list of values in this control. In this case, it’s using
all the TypeID and Description values from the Types table to build the list.
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■ The Column Count property is set to 2—This tells the form that there
are two columns in the row source.

■ The Column Widths property is set to 0''; 1''—This tells the form that
the first column should be hidden (by setting its width to 0) and the second
column should be 1'' wide.

■ The Bound Column property is set to 1—This tells the form that when
the user selects a row in the list, the value from the first column of that row
should be stored in the field specified by the control source property.

■ The List Rows property is set to 8—This is the maximum number of
rows Access will display in the drop-down list at once. If more than eight rows
are in the list, Access displays a scrollbar.

■ The Limit to List property is set to Yes—This prevents the user from
entering a value not in the list.

Access also offers a useful tool to change the type of a control, which comes in
handy when you change your mind about the best user interface for a form. For
example, the Plants form currently contains a text box to enter the catalog, but you
know that all the catalogs are listed in the Catalogs table. By converting this control
to a combo box, you can let the user select from a list rather than forcing her to type
in a value:

1. Select the Type list box you created earlier in this section, and press the
Delete key to remove it from the form. This will also remove the associated
label control.

2. Select the CatalogName text box.

3. Select Format, Change To, Combo Box.

4. Click in the Row Source property for the new combo box, which displays a
build button. Click the build button.

5. Select the Catalogs table in the Show Table dialog box and click Add.

6. Click Close to dismiss the Show Table dialog box.

7. Drag the Name column from the field listing in the Query Builder down to
the query grid. Set the Sort property for this field to Ascending.

8. Click the Close button to close the Query Builder.

9. Access displays an error message, as shown in Figure 13.14. Even though this
is not the friendliest dialog box possible, its appearance is completely normal.
Click Yes to finish building the Row Source property. 
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10. Set the Column Widths property by typing 1.5”.

11. Set the Limit to List property by selecting Yes.

12. Save the form.

13. Switch to form view. Now you can select the catalog name from a list, instead
of having to type it in for each record.

Command Buttons
The last important control that we’ll look at in this chapter is the Command Button
control. Command buttons, as you might guess from their name, are used to tell
Access to do something. To get deeply into the subject of commands requires more
programming than you’ll learn in this book, although there’s a short introduction in
Chapter 15. But for now, you’ll use one of the Control wizards to construct a com-
mand button to give you a feel for what they can do. Follow these steps:

1. Open the Plants form in design view.

2. Click the Command Button button in the Toolbox.

3. Click in an empty area on the form to launch the Command Button Wizard,
shown in Figure 13.15.
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4. Select Report Operations in the Categories list. Then select Preview
Report in the Actions list and click Next.

5. On the second panel of the wizard, select the Plants report. Click Next.

6. On the third panel of the wizard, accept the default picture and click Next.

7. On the final panel of the wizard, accept the default name and click Finish.

8. Save the form and switch back to form view.

9. Click the newly created button. The Plants report opens in print preview view.

Working with Sections and Subforms
Now we’ll take a brief look at two more form design topics: sections and subforms.
Access forms can have multiple sections and can display subforms.

Form Sections
Form sections provide a way to logically group some of the controls on forms. The list
of available sections is fixed by Access. In practice, the following are the three sec-
tions you’re likely to use:

■ Form header—This section appears at the top of the form, above all the
records.

■ Form detail—This section is where the actual records appear. The detail sec-
tion might be displayed many times, if you have the form set to continuous
view.

■ Form footer—This section appears at the bottom of the form, below all the
records.

To see form sections in action, you can work with the Catalogs form by doing the
following:

1. Open the Catalogs form in design view.

2. In design view, you’ll see several gray bars running the width of the form.
You might have ignored these, but now you can see that they mark the sec-
tions of the form. Place your cursor at the bottom of the Form Footer bar and
drag it downward to create an actual footer section.

3. Click the Command Button control in the Toolbox.

4. Click in an empty area in the footer section of the form to launch the
Command Button Wizard.

5. Select Record Navigation in the Categories list. Then select Go To Last
Record in the Actions list and click Next.
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6. On the second panel of the wizard,
accept the default picture and click
Next.

7. On the final panel of the wizard,
accept the default name and click
Finish.

8. Save the form and switch back to form
view.

Figure 13.16 shows the modified form. You
can see that the controls in the form header
(the labels for Name, Address, and so on)
appear only once at the top of the form. The con-
trols in the detail section appear multiple times, and the command button control in
the form footer appears only once at the bottom of the form.

Subforms
You first saw a subform in Chapter 8, “Creating and Using Data Entry Forms.” Now
we’ll take a brief look at using subforms in design view. As you’ll recall, a subform
lets you show a group of related records on a parent form. For example, on the
CatalogsMain form, the main part of the form (the parent form) displays informa-
tion on types, whereas the subform displays a list of plants of the currently displayed
type.
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FIGURE 13.16

Form sections in

action.

To see the details of how forms and subforms work together, follow these steps:

1. Open the TypesMain form in design view.

2. Click the subform area in design view. You can tell the subform because it
has its own set of rulers and its own header and detail section.
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3. Inspect the Properties window for the subform. The Link Child Fields and Link
Master Fields properties specify how the form and subform are related. At any
time, the subform displays records whose Link Child Fields have the same
value as the current Link Master Fields values on the main form.

4. Although you can edit the subform directly in the main form, this can get
confusing. Click outside of the subform to deselect it. Then right-click the sub-
form and select Subform in New Window to edit the subform in a new
window, as shown in Figure 13.17.
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design view.

5. Select the form header in the subform by clicking the gray bar above the
header.

6. Change the Back Color property of the subform header by clicking in the
property and using the build button to select a new color.

7. Click the Save button to save the changes to the subform.

8. Close the subform.

9. Switch the main form back to design view; the subform now has the colored
header you selected. 

Object Dependencies
By now you’re starting to accumulate quite a few objects in your database. Access
keeps track of the relationships between these objects, and it can show them to you
as well. To see this in action, follow these steps:

1. Click the Tables shortcut in the database window.

2. Right-click the Catalogs table and select Object Dependencies.
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The dependent objects are presented in a treeview. You can click the plus signs to
expand the treeview, up to four levels deep. For example, in this case clicking the +
sign next to the Plants table will show you the objects that depend directly on that
table.

This default view allows you to perform easy impact analysis. You can immediately
see which objects in your database will be affected by a change to the selected
object. This lets you see the repercussions of major changes (such as deleting an
object or changing the columns returned by a query) before you make them.

You can also reverse the process and see the ancestors of the selected object by click-
ing the Objects That I Depend On option button in the Object Dependencies task
pane. 
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3. Access may ask whether to update the dependency information in the data-
base. Click OK.

4. Access will display the dependency information in a task pane at the side of
the screen, as shown in Figure 13.18.
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The Absolute Minimum
We covered a lot of ground in this chapter, and yet we did not see everything that
you can do in form design mode. This is one of the areas of Access where there is
much more depth than we can cover in an introductory book. As you’re working
with forms in design mode, keep these points in mind:

■ AutoFormats enable you to quickly change the appearance of a form.

■ The Field List can be used to add new bound controls to a form.

■ Both forms and the controls on forms have properties that control their
appearances and behaviors. You can alter these properties by manipulating
the controls directly or by changing values in the Properties window.

■ The Toolbox enables you to add new controls of various types to your Access
forms.

■ Sections and subforms provide more advanced ways of managing the design
of forms.

■ You can use the Object Dependencies task pane to see how the objects in your
database are related.
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